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INTRODUCTION 

The USGS Biological Resources Division Gulf of Mexico Ecosystem 
Model was developed by LGL Ecological Research Associates, Inc . using 
Habitat Evaluation Program (HEP) techniques to produce maps and tables that 
can be displayed in ArcView 2.1, a powerful, easy-to-use tool that brings 
geographic information to the desktop . Many parts of this user manual that 
relate to ArcView functions come from the HELP files supplied with 
ArcView. 

ArcView is made by Environmental Systems Research Institute (ESRI), 
the makers of ARC/INFO. 

Working Spatially 

ArcView can be used by anyone who wants to work spatially . A key 
feature of ArcView is that it's easy to load tabular data, such as dBASE files 
and data from database servers, into ArcView so that you can display, query, 
summarize, and organize this data geographically . 

Views 

With ArcView you work with geographic data in interactive maps 
called views . Every view features ArcView's unique geographic 'Table of 
Contents', making it easy to understand and control what's displayed . Each 
component of the HEP model includes one view, with the species being 
modeled, depth contours, platform locations, and MMS lease block areas 
available to be displayed . 

Tables 

Underlying tables accompany each modeled species (themes in 
ArcView). You can work with the tabular data for any theme by clicking the 
Tables. . . element under the Theme menu. Click on features on a view, and 
their records highlight in the table showing you their attributes . Select 
records in the table and the features they represent highlight on the view. 
ArcView's tables also have a full range of features for obtaining summary 
statistics, sorting and querying. They can also be printed. 

Charts 

ArcView's charts offer a powerful graphics and data visualization 
capability that is fully integrated into ArcView's geographic environment . 
You can simply click on features on a view to add them to the chart. ArcView 
lets you work simultaneously with geographic, tabular and chart 
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representations of your data. No prepared charts are included in the HEP 
model projects . 

Layouts 

ArcView's layouts let you create high quality, full color maps by first 
arranging the various graphic elements on-screen the way you want them. 
You'll get great looking results on a wide range of printers and plotters . 
Layouts are smart because they have a live link to the data they represent. 
When you print a layout, any changes to the data are automatically included, 
so you know everything on your map will be up-to-date . Each HEP model 
project includes two standardized layouts; an introduction page that displays 
upon opening the project, and a layout for printing the active themes of the 
project. 

Scripts 

ArcView scripts are macros written in Avenue, ArcView's 
programming language and development environment. Several scripts are 
included with the HEP model, including the startup script, which configures 
the project to look the same upon opening each time, and the button scripts 
to automatically query the model themes to display only modeled polygons, 
and to set the legend of the model theme to a standard format. 

Projects 

Two ArcView projects are included in the HEP model: adult.apr and 
juvenile .apr . Each of the projects is all-inclusive and includes the model 
themes, tables and layouts for that version of the model . 

Spatial data 

Spatial data is at the heart of every ArcView application. Spatial data is 
geographic data that stores the geometric location of particular features, along 
with attribute information describing what these features represent . The 
coastline, depth contours, Federal lease areas, and species modeled themes in 
the HEP model projects are all ARC/INFO coverages that have been added to 
the view. 

Tabular data 

Tabular data can include almost any data set, whether or not it contains 
geographic data. What you can do with a table in ArcView depends on what it 
contains . Some tables can be displayed on a view directly, others provide 
additional attributes that can be joined to your existing spatial data. The 
Platform theme in the HEP model project is an event theme that is displayed 
based on the comma separated values file included with the projects . 
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USING THE MODEL 

Here are some of the key tasks you can accomplish with ArcView. 

Display ARC/INFO Data on a View 

Turning themes on and off 

You can control which themes are drawn in your view by simply 
turning them on or off. Use the check box that's next to a theme in the Table 
of Contents to turn the theme on or off. 

Changing the order themes are drawn in 

Simply drag themes up and down in the Table of Contents to change 
the order they are drawn in . The theme at the top of the Table of Contents is 
drawn on top of those below it. Put themes that form the background to your 
view at the bottom of the Table of Contents. 

Zoom in¢ 

There are several ways to zoom in and out on a view. In addition to 
zooming in and out with the zoom tools, you can zoom in on particular 
themes . You can also automatically zoom in on the geographic features that 
you select on a view. 

View scale 

As you zoom in and out on your view, ArcView always shows you its 
current scale . You can also specify the scale you wish to use for your view 
directly, as an alternative to zooming in and out manually . 

Panning around a view 

Using the Pan tool, simply drag the view display to pan around . 

Display Tabular Data on a View 

You can import tabular data and then join it to the data in a view to 
display it geographically . 

Use SQL to retrieve records from a database and display them on a 
view 
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You can connect to a database to get a tabular data and then work with 
it geographically . 

Geocode tables containing addresses and display them on a view 

Any tabular data containing the addresses of facilities, etc . can be 
displayed on a view as points. ArcView geocodes this data in order to add it to 
a view. 

Find the attributes of any features on a view 

You can click on features on a view to display their attributes . 

Select features according to their attributes 

You can query a view to find particular features . 

Summarize the attributes of features 

For example, you can summarize data for cells on a regional or other 
basis . You can also generate statistics about any attributes . 

Select features based on their proximity to other features 

Find places where certain features coincide 

Layout a mad and print it 

An ArcView project can contain any number of layouts . 

To see which layouts are in a project 

Click on the Layouts icon on the Project window . The layouts in the 
current project are shown in the list . 

To create a new layout 

With the Layouts icon selected, click the New button at the top of the 
Project window . ArcView creates a new layout and its name will appear in 
the list of layouts in the project. ArcView names new layouts in numerical 
order : Layoutl, Layout2, Layout3, etc . You can also double-click the Layouts 
icon to create a new layout. 

To open a layout 

Double-click the layout's name in the list of layouts in the Project 
window, or select the layout's name and click the Open button. 
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To close a layout 

From the File menu, choose Close, or click the close option on the 
layout's window (This option varies according to the GUI you are using) . 

To rename a layout 

Click once on the layout in the list in the Project window and choose 
Rename from the Project menu. A layout's name is also a layout property 
you can edit . 

To save the work you do with a layout 

In ArcView, you save the work you do with any project component by 
saving the project. To save your project, choose Save Project from the File 
menu or click the Save Project button in the Layout button bar. 

To copy a layout from one project to another 

If you want to copy a layout from another project into your current 
project, you should import the other project into your current one using 
Import in the Project menu. This will copy all the components of the other 
project into your current project. You can then delete the components that 
you don't require using Delete from the Project menu. 

Layout a mad and exhort it for use in another program 

Map layouts can be exported to various file formats. 

Navigating the model screen 

Locations of buttons, tool bars, and menu bars are provided in Figure 1. 
Of special note are the two buttons located immediately after the disk icon on 
the button bar. The first button, marked with a "Q" icon will recreate the 
correct query for the selected theme, to display only modeled cells. The 
second button, marked with a paint brush, will restore the legend of the 
selected theme to four equal units of HSI colored from gray to red . 
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Figure 1 . Navigating the Model Screen 
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CONTENTS OF THE ADULT MODEL 

The adult.apr project comes with one view (Habitat Suitability Indices 
for Adult Reef Fish), one table (allplat.csv), and two layouts (Introduction, 
and Layoutl). The view includes twelve themes for display: 

Theme Description 
Gulf Coast ARC/INFO coverage of the coastline 

of the Gulf of Mexico 
Federal Lease Areas ARC/INFO coverage of Federal lease 

areas obtained from MMS 
Oil and Gas Platforms ArcView event theme created from 

the text file allplats.csv, included 
operator name, lat/lon and lease 
block information 

10 Fathom contour ARC/INFO coverage providing the 
approximate location of the 10 
fathom depth contour 

20 Fathom contour as above 
30 Fathom contour as above 
Red Snapper HEP model for adult Lutjanus 

Campechanus 
Other Snapper HEP model for all snapper other than 

red snapper as identified by 
fishermen in David Stanley's research 

Cobia HEP model for fish identified as cobia 
Triggerfish 
Grouper HEP model for all species identified as 

grouper 
Amberjack 

Columnar data in the attributes table for any of the model themes 
describe the characteristics of a modeled cell, and the HSI calculations for the 
cell . The content of each of the columns is described below. Surface dwelling 
species include model values for surface temperature and surface salinity; 
bottom dwelling species use bottom temperature and bottom salinity . 

LATDD. Represents the latitude coordinate of the upper left hand corner of 
the modeled ten minute square cell . 

LONDD. Represents the longitude coordinate of the upper left hand corner of 
the modeled ten minute square cell . 
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HA-ID. An internal number used to uniquely identify a model cell and 
allow it to be matched with the corresponding polygon in the ARC/INFO 
coverage that represents all sampled cells. 

DFATHS . The 10 fathom range where the mean value of all depth 
observations within the modeled cell occurs. The descriptor is the mid-point 
of the range (i.e ., value of 10 represents range of 5 fathoms to 15 fathoms) . 

PLATCNT. Number of platforms located in the modeled cell . 

HANGCNT. Number of hangs (calculated from the Texas A & M Sea Grant 
hang location file) located in the modeled cell . 

DEADCNT. The number of years during the last eleven years that the 
modeled cell has been included in the mapped dead zone. 

RELIDX. Suitability index value to importance of relief at a particular depth 
on species of interest within a modeled cell . This can be used to calculate the 
value of each platform in a modeled cell for the species of interest, as the 
depth/relief component of the final HSI for any cell is calculated as the 
relationship of the natural log of (the platform count plus one-half of the 
hang count multiplied times this value) divided by the highest occurring 
such value for any modeled cell . 

SPPVAL. Platform count plus one-half of the hang count times the relidx 
value . 

LSPPVAL. Natural log of sppval variable plus 1 . 

HSI. Habitat Suitability Index for the species of interest in the modeled cell . 

Columns unique to pelagic fish : 

SURTMP . Mean value of all surface temperature observations within the 
modeled cell . 

SURSAL. Mean value of all surface salinity observations within the modeled 
cell . 

STMPIDX. Surface temperature suitability index value. 

SSALIDX. Surface salinity suitability index value. 

Columns unique to bottom fish : 
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BOTTMP. Mean value of all bottom temperature observations within the 
modeled cell . 

BOTSAL . Mean value of all bottom salinity observations within the modeled 
cell . 

BTMPIDX. Bottom temperature suitability index value . 

BSALIDX. Bottom salinity suitability index value. 

The table allplat.csv holds information about platforms located in the 
Western Gulf of Mexico. The data held in each record include the latitude 
and longitude coordinates of the platform location, operator of the platform, 
lease block area and number, and the platform identifier. 
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CONTENTS OF THE JUVENILE MODEL 

The juvenile .apr project comes with one view (Habitat Suitability 
Indices for Trawlable Ages), one table (allplat.csv), and two layouts 
(Introduction, and Layoutl) . The view includes thirteen themes for display: 

Theme Description 
Gulf Coast ARC/INFO coverage of the coastline 

of the Gulf of Mexico 
Federal Lease Areas ARC/INFO coverage of Federal lease 

areas obtained from MMS 
Oil and Gas Platforms ArcView event theme created from 

the text file allplats.csv, included 
operator name, lat/lon and lease 
block information 

10 Fathom contour ARC/INFO coverage providing the 
approximate location of the 10 
fathom depth contour 

20 Fathom contour as above 
30 Fathom contour as above 
Red Snapper HEP model for juvenile Lutjanus 

campechanus 
Brown Shrimp HEP model for all ages of Penaeus 

aztecus 
White Shrimp HEP model for all ages of Penaeus 

setiferus 
Vermilion Snapper HEP model for juvenile 

Rhomboplites aurorubens 
Trachypenaeus HEP model for all ages of 

Trachypenaeus 
Atlantic Croaker HEP model for juvenile 

Micropogonias undulatus 
Gulf Flounder HEP model for juvenile Paralichthys 

albigutta 

Columnar data in the attributes table for any of the model themes 
provide each of the suitability indices used to calculate the final HSI of a 
modeled cell, as well as the HSI value for the cell . The content of each of the 
columns is described below . 

SALIDX. Suitability index value corresponding to the mean value of all 
bottom salinity observations within the modeled cell . 

LATDD. Represents the latitude coordinate of the upper left hand corner of 
the modeled cell . 
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LONDD. Represents the longitude coordinate of the upper left hand corner of 
the modeled cell . 

PLATSI. Suitability index based on the range (groups of 5) within which the 
number of platforms in the modeled cell falls . 

HANGSI . Suitability index based on the range (groups of 10) within which 
the number of hangs in the modeled cell falls. 

DEADSI. Suitability index based on the number of years the cell has been 
located in a dead zone area during the last 11 years. 

DPZSI. Suitability index based on the mean 10 fathom depth range of all 
observations within the modeled cell . 

TMPSI. Suitability index component based on the mean value of all 
observations of bottom temperature in the modeled cell . 

HSI. Habitat Suitability Index for the species of interest in the modeled cell . 

HA-ID. An internal number used to uniquely identify a model cell and link 
it to ARC/INFO polygons of modeled cells . 
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CONTENTS OF THE PLATFORM ASSESSMENT MODEL 

The assess.apr project comes with one view (Red Snapper Assessment), 
one table (allplat.csv), and one layout. The view includes 10 themes for 
display: 

Theme Description 
Gulf Coast ARC/INFO coverage of the coastline 

of the Gulf of Mexico 
Federal Lease Areas ARC/INFO coverage of Federal lease 

areas obtained from MMS 
Oil and Gas Platforms ArcView event theme created from 

the text file allplats.csv, included 
operator name, lat/lon and lease 
block information 

10 Fathom contour ARC/INFO coverage providing the 
approximate location of the 10 
fathom depth contour 

20 Fathom contour as above 
30 Fathom contour as above 
Red Snapper - Current HSI values HEP model for adult red snapper 

based on platforms in place as of 1995 
Red Snapper - HSI values in 1986 HEP model for adult red snapper 

based on platforms in place in 1995 
plus platforms removed between 1986 
and 1994 

Platform Assessment Model HEP model for red snapper with 
larger emphasis on value of 
platforms to allow calculation of cost 
of removal and value of addition 

Removed Platforms Display of platforms removed from 
model cells from 1986 to 1994 

Columnar data in the attributes table for any of the model themes 
provide each of the suitability indices used to calculate the final HSI of a 
modeled cell, as well as the HSI value for the cell . The content of each of the 
columns is described below. 

LATDD. Represents the latitude coordinate of the upper left hand corner of 
the modeled ten minute square cell . 

LONDD. Represents the longitude coordinate of the upper left hand corner of 
the modeled ten minute square cell . 
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HA_ID. An internal number used to uniquely identify a model cell and 
allow it to be matched with the corresponding polygon in the ARC/INFO 
coverage that represents all sampled cells . 

DFATHS. The 10 fathom range where the mean value of all depth 
observations within the modeled cell occurs. The descriptor is the mid-point 
of the range (i.e ., value of 10 represents range of 5 fathoms to 15 fathoms) . 

PLATCNT. Number of platforms located in the modeled cell . 

HANGCNT. Number of hangs (calculated from the Texas A & M Sea Grant 
hang location file) located in the modeled cell . 

DEADCNT. The number of years during the last eleven years that the 
modeled cell has been included in the mapped dead zone. 

RELIDX. Suitability index value to importance of relief at a particular depth 
on species of interest within a modeled cell . This can be used to calculate the 
value of each platform in a modeled cell for the species of interest, as the 
depth/relief component of the final HSI for any cell is calculated as the 
relationship of the natural log of (the platform count plus one-half of the 
hang count multiplied times this value) divided by the highest occurring 
such value for any modeled cell . 

SPPVAL. Platform count plus one-half of the hang count times the relidx 
value . 

LSPPVAL. Natural log of sppval variable plus 1 . 

HSI. Habitat Suitability Index for the species of interest in the modeled cell . 

BOTTMP. Mean value of all bottom temperature observations within the 
modeled cell . 

BOTSAL. Mean value of all bottom salinity observations within the modeled 
cell . 

BTMPIDX. Bottom temperature suitability index value. 

BSALIDX. Bottom salinity suitability index value. 

Additional columns restricted to the theme Red Snapper HSI Values in 1986 : 

REM86 through REM94. The number of platforms removed from a model 
cell for each of the years 1986 - 1994 . 

13 



TOTREM . Total platforms removed from a cell during 1986 - 1994. 

REMSPP . The same calculation as SPPVAL, made with the removals added 
back . 

LREMSPP. The natural log of REMSPP + 1 . 

OLDHSI. Where this variable is included it represents the HSI values for the 
cell after removal of all platforms. 

STDPIDX. The ratio of the LREMSPP to the maximum occurring value of 
LREMSPP. 

Additional columns occurring in the Platform Assessment Model theme: 

SUITFACT . This factor represents the approximate value of a single platform 
to the model cell . When multiplied by the number of platforms and one-
tenth the number of hangs in a cell it produces CELLVAL. 

CELLVAL. This is the raw value of the underlying habitat components in the 
assessment model. 

GOODCELL . This value is one-half the value of optimum habitat. HSI is 
calculated as a ratio of CELLVAL to twice GOODCELL, up to a value of 1. 

HOWMANY. This factor represents the number of platforms that may be 
removed from a model cell before the cell will move to the next lower 
quarter of HSI values . For cells in the bottom quarter this value is by 
definition the total number of platforms in the cell . 

The table allplat.csv holds information about platforms located in the 
Western Gulf of Mexico. The data held in each record include the latitude 
and longitude coordinates of the platform location, operator of the platform, 
lease block area and number, and the platform identifier . 

Calculation of new habitat values for any model cell can be completed 
using the underlying values of the attribute table for a cell . For each platform 
removed, the user should subtract one unit of SUITFACT from the value of 
CELLVAL, then compare the result to twice the value of GOODCELL. If the 
ratio is greater than 1, it should be rounded to 1, otherwise the ratio is the 
predicted HSI value for the cell . 
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ORACLE TABLES OF SUITABILITY INDICES 

Appendix 1 provides table and column descriptions for each of the 
habitat model suitability indexes for the seven species subject to trawling and 
the six adult reef fish species included in the models . 

Columns are similar in each of the modeled species, differing between 
adult and trawlable, and surface and bottom dwelling members of the adult 
models . 

Common Name 
Amberjack 

Brown Shrimp 

Oracle Table 
Amberj_ad hsi 

Description 
Adult Amberjack -
Surface 
Brown shrimp - trawl 
model 
Adult Cobia - Surface 
Juvenile croaker 

Scientific Name 

Penaeus aztecus 

Biocode 

228010701 br_shrimp hsi 

Cobia cobia ad hsi 
Atlantic Croaker croak_juv_hsi 

Gulf Flounder 

Grouper 
Other Snapper 

Red Snapper 

Red Snapper 

floun juv_hsi 

grouper_ad hsi 
othsnap_ad hsi 

redsnap_ad hsi 

rs_juv hsi 

Juvenile flounder 

Adult grouper - bottom 
Adult snapper other 
than red snapper -
bottom 
Adult red snapper -
bottom 
Juvenile red snapper 

Blood Shrimp trachy hsi 
Triggerfish trigger_ad hsi Adult Triggerfish 
Vermilion vsnap_juv hsi Juvenile vermilion 
Snapper snapper 
White Shrimp wh_shrimp hsi White shrimp - trawl 

model 

Columns for surface adult reef fish : 

Micropogonias 
undulatus 
Paralichthys 
albigutta 

Lutjanus 
campechanus 
Trachypenaeus 

Rhomboplites 
aurorubens 
Penaeus setiferus 

170201902 

183012401 

170151107 

228011800 

170152001 

228010705 

LATDD. Represents the latitude coordinate of the upper left hand corner of 
the modeled cell . 

LONDD. Represents the longitude coordinate of the upper left hand corner of 
the modeled cell . 

HA-ID. An internal number used to uniquely identify a model cell . 

SURTMP. Mean value of all surface temperature observations within the 
modeled cell . 
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SURSAL. Mean value of all surface salinity observations within the modeled 
cell . 

DFATHS. The 10 fathom range where the mean value of all depth 
observations within the modeled cell occurs . 

PLATCNT. Number of platforms located in the modeled cell . 

RELIDX. Suitability index value to importance of relief at a particular depth 
on species of interest within a modeled cell . This can be used to calculate the 
value of each platform in a modeled cell for the species of interest, as the 
depth/relief component of the final HSI for any cell is calculated as the 
relationship of the natural log of (the platform count plus one-half of the 
hang count multiplied times this value) divided by the highest occurring 
such value for any modeled cell . 

SPPVAL. Platform count plus one-half of the hang count times the relidx 
value . 

LSPPVAL. Natural log of sppval variable plus 1 . 

HSI. Habitat Suitability Index for the species of interest in the modeled cell . 

STMPIDX. Surface temperature suitability index value. 

SSALIDX. Surface salinity suitability index value. 

Columns for bottom adult reef fish : 

LATDD. Represents the latitude coordinate of the upper left hand corner of 
the modeled cell . 

LONDD. Represents the longitude coordinate of the upper left hand corner of 
the modeled cell . 

HA-ID. An internal number used to uniquely identify a model cell . 

BOTTMP . Mean value of all bottom temperature observations within the 
modeled cell . 

BOTSAL. Mean value of all bottom salinity observations within the modeled 
cell . 

DFATHS . The 10 fathom range where the mean value of all depth 
observations within the modeled cell occurs. 
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PLATCNT. Number of platforms located in the modeled cell . 

RELIDX. Suitability index value to importance of relief (combination of 
platforms and hangs) on species of interest within a modeled cell . 

SPPVAL. Platform count plus one-half of the hang count times the relidx 
value . 

LSPPVAL. Natural log of sppval variable plus 1 . 

HSI. Habitat Suitability Index for the species of interest in the modeled cell . 

BTMPIDX. Bottom temperature suitability index value. 

BSALIDX. Bottom salinity suitability index value. 

Columns for trawlable species model: 

SALIDX . Suitability index value for the mean value of all salinity 
observations within the modeled cell . 

LATDD. Represents the latitude coordinate of the upper left hand corner of 
the modeled cell . 

LONDD. Represents the longitude coordinate of the upper left hand corner of 
the modeled cell . 

PLATSI . Suitability index based on count of platforms in the modeled cell . 

HANGSI. Suitability index based on count of hangs in the modeled cell . 

DEADSI. Suitability index based on the number of times the cell has been 
located in a dead zone area during the last 11 years . 

DPZSI. Suitability index based on the mean depth of all observations within 
the modeled cell . 

TMPSI. Suitability index component based on the mean value of all 
observations of bottom temperature in the modeled cell . 

HSI. Habitat Suitability Index for the species of interest in the modeled cell . 

HA-ID. An internal number used to uniquely identify a model cell . 
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APPENDIX 1 

ORACLE TABLES 
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ORACLE Tables: 

TABLE NAME COLUMN NAME DATA TYPE 

AMBERJ AD HSI LATDD NUMBER 
LONDD NUMBER 
HA ID NUMBER 
SUR'TIvIIP NUMBER 
SURSAL NUMBER 
DFATHS NUMBER 
PLATCNT NUMBER 
RELIDX NUMBER 
SPPVAL NUMBER 
LSPPVAL NUMBER 
HSI NUMBER 
STIVII'IDX NUMBER 
SSALIDX NUMBER 

BR SHRIMP HSI SALIDX NUMBER 
LATDD NUMBER 
LONDD NUMBER 
PLATS NUMBER 
HANGS NUMBER 
DEADSI NUMBER 
DPZSI NUMBER 
TNII'SI NUMBER 
HSI NUMBER 
HA ID NUMBER 

COBIA AD HSI LATDD NUMBER 
LONDD NUMBER 
HA ID NUMBER 
SURTMP NUMBER 
SURSAL NUMBER 
DFATHS NUMBER 
PLATCNT NUMBER 
RELIDX NUMBER 
SPPVAL NUMBER 
LSPPVAL NUMBER 
HSI NUMBER 
S'TNII'IDX NUMBER 
SSALIDX NUMBER 
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TABLE NAME COLUMN NAME DATA TYPE 

CROAKJUV HSI SALIDX NUMBER 
LATDD NUMBER 
LONDD NUMBER 
PLATS NUMBER 
HANGSI NUMBER 
DEADSI NUMBER 
DPZSI NUMBER 
TIvII'SI NUMBER 
HSI NUMBER 
HA ID NUMBER 

FLOUN,JUV HSI SALIDX NUMBER 
LATDD NUMBER 
LONDD NUMBER 
PLATS NUMBER 
HANGSI NUMBER 
DEADSI NUMBER 
DPZSI NUMBER 
TMII'SI NUMBER 
HSI NUMBER 
HA ID NUMBER 

GROUPER AD HSI LATDD NUMBER 
LONDD NUMBER 
HA ID NUMBER 
BOTTMI' NUMBER 
BOTSAL NUMBER 
DFATHS NUMBER 
PLATCNT NUMBER 
REL.IDX NUMBER 
SPPVAL NUMBER 
LSPPVAL NUMBER 
HSI NUMBER 
TIvII'SI NUMBER 
BTNPIDX NUMBER 
BSALIDX NUMBER 
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TABLE NAME COLUMN NAME DATA TYPE 

OTHSNAP AD HSI LATDD NUMBER 
LONDD NUMBER 
HA ID NUMBER 
BOTTNII' NUMBER 
BO'ISAL NUMBER 
DFATHS NUMBER 
PLATCNT NUMBER 
RELIDX NUMBER 
SPPVAL NUMBER 
LSPPVAL NUMBER 
HSI NUMBER 
TMPSI NUMBER 
BT1VII'IDX NUMBER 
BSALIDX NUMBER 

REDSNAP AD HSI LATDD NUMBER 
LONDD NUMBER 
HA ID NUMBER 
BOTTMP NUMBER 
BOTSAL NUMBER 
DFATHS NUMBER 
PLATCNf NUMBER 
RELIDX NUMBER 
SPPVAL NUMBER 
LSPPVAL NUMBER 
FBI NUMBER 
TMPSI NUMBER 
BTIvII'IDX NUMBER 
BSALIDX NUMBER 

RS,JUV_HSI SALIDX NUMBER 
LATDD NUMBER 
LONDD NUMBER 
PLATSI NUMBER 
HANGSI NUMBER 
DEADSI NUMBER 
DPZSI NUMBER 
TMPSI NUMBER 
HSI NUMBER 
HA ID NUMBER 

TRACHY HSI SALIDX NUMBER 
LATDD NUMBER 
LONDD NUMBER 
PLATS NUMBER 
HANGSI NUMBER 
DEADSI NUMBER 
DPZSI NUMBER 
TMPSI NUMBER 
HSI NUMBER 
HA ID NUMBER 
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TABLE NAME COLUMN NAME DATA TYPE 

TRIGGER AD HSI LATDD NUMBER 
LONDD NUMBER 
HA ID NUMBER 
SURTNII' NUMBER 
SURSAL NUMBER 
DFATHS NUMBER 
PLATCNT NUMBER 
RELIDX NUMBER 
SPPVAL NUMBER 
LSPPVAL NUMBER 
HSI NUMBER 
STNII'IDX NUMBER 
SSALIDX NUMBER 

VSNAP,JUV_HSI SALIDX NUMBER 
LATDD NUMBER 
LONDD NUMBER 
PLATS NUMBER 
HANGSI NUMBER 
DEADSI NUMBER 
DPZSI NUMBER 
TIvII'SI NUMBER 
HSI NUMBER 
HA ID NUMBER 

WH SHRIMP HSI SALIDX NUMBER 
LATDD NUMBER 
LONDD NUMBER 
PLATS NUMBER 
HANGS NUMBER 
DEADSI NUMBER 
DPZSI NUMBER 
TMI'SI NUMBER 
HSI NUMBER 
HA ID NUMBER 
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QPPS~E,NT OF ly~y The Department of the Interior Mission 

As the Nation's principal conservation agency, the Department of the Interior has responsibility 
for most of our nationally owned public lands and natural resources. This includes fostering 
sound use of our land and water resources; protecting our fish, wildlife, and biological diversity ; 
preserving the environmental and cultural values of our national parks and historical places ; 

~4RCH 3 ~ep9 and providing for the enjoyment of life through outdoor recreation . The Department assesses 
our energy and mineral resources and works to ensure that their development is in the best 
interests of all our people by encouraging stewardship and citizen participation in their care . 
The Department also has a major responsibility for American Indian reservation communities 
and for people who live in island territories under U.S . administration . 

o`Q~4~6~or The Minerals Management Service Mission 

As a bureau of the Department of the Interior, the Minerals Management Service's (MMS) 
¬ w primary responsibilities are to manage the mineral resources located on the Nation's Outer 

Continental Shelf (OCS), collect revenue from the Federal OCS and onshore Federal and Indian 
lands, and distribute those revenues . 

Moreover, in working to meet its responsibilities, the Offshore Minerals Management Program 
administers the OCS competitive leasing program and oversees the safe and environmentally 
sound exploration and production of our Nation's offshore natural gas, oil and other mineral 
resources. The MMS Minerals Revenue Management meets its responsibilities by ensuring the 
efficient, timely and accurate collection and disbursement of revenue from mineral leasing and 
production due to Indian tribes and allottees, States and the U.S . Treasury . 

The MMS strives to fulfill its responsibilities through the general guiding principles of: (1) being 
responsive to the public's concerns and interests by maintaining a dialogue with all potentially 
affected parties and (2) carrying out its programs with an emphasis on working to enhance the 
quality of life for all Americans by lending MMS assistance and expertise to economic 
development and environmental protection . 
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